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Section One:  
Introduction to the Windows Environment 
 
Objectives 
 

• Identify and use computer hardware. 
• Open and close a desired program. 
• Switch back and forth between open windows. 
• Create and save a Word document on a floppy disc. 

 
Handouts 
Mouse Basics 
Practice Using the Mouse 
An Introduction to File Structure 
 
Topic Overview 

Topic Estimated Time 

Introduction to the Computer Hardware 5 

The Windows Desktop 5 

Working With Windows 20 

Working With Files 10 
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Introduction to the Computer Hardware 
Estimated time: 5 minutes 
 
What is a computer? 
 

• A tool for accessing information. 
• A PC is a personal computer – a one person or single user computer. 
• A computer does not think on its own. You have to tell it what to do.   
 

A computer is made up of multiple parts that either send or receive 
information. All computers will have at least the following parts:  
 

• Computer Case: Inside the case is where everything takes place. The 
hard drive, ram chips, CPU, and motherboard are all found inside the 
computer case.  

• Monitor: Similar to a television, this displays text, pictures, and other 
items from the computer. 

• Keyboard: Allows you to type information into the computer. 
• Mouse: Controls the pointer displayed on the monitor. You use the 

mouse pointer to select and open items on the computer. 
 
There are three disc drives commonly accessible from the front of the 
computer case. The DVD-ROM drive has the words compact disc on the face. 
The DVD-ROM drive reads both CD-ROMs and DVD-ROMs. The compact and 
floppy disc drives look similar, but the compact disc drive has a larger slot 
since the disc is larger. The compact drive also has the word compact on the 
face. You can save files such as letters, pictures, and presentations on either 
compact discs or floppy discs. For larger or more files, save your work on a 
compact disc, for smaller or less files, save your work on a floppy disc.  
 
Activity: Locate the Parts of a Computer 
Locate the monitor, keyboard, mouse, and computer case. Also locate the 
floppy and/or compact disc drives. 
 
Review Questions 
You'll find the answers at the end of the workbook. 
 
1. How can you tell the difference between the floppy and compact disc 

drives? 
 
             
 
             
 
2. How would you decide which to use? 
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3. What do you use the mouse for? 
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The Windows Desktop 
Estimated time: 5 minutes 
 
When you first log on to the computer, you see the Windows desktop. Icons 
representing the programs that are available on the computer are visible. 
You should also see the gray taskbar that runs along the bottom of the 
screen. The desktop can be thought of as the launch pad for your computer 
work.  
 
Activity: Locating Items on the Windows Desktop 
Locate the following items on the Desktop: 
 

• Taskbar 
• Microsoft Word icon 
• Mouse pointer 
• Start button 

 
Activity: Starting a Program 
Handout: Mouse Basics 
 
You start, or open, a program by double-clicking its icon on the desktop. 
Once a program opens, the program is visible as a window on the computer 
screen and a button representing the program appears on the taskbar.  
 
Hint: If you have trouble double-clicking, you can click an icon once, then 
press the Enter key on the keyboard. 
 
Open a Program from the Start Menu 
All of the programs that are available from the desktop are also available on 
the Start menu. 
 
1. Click the Start button on the taskbar. A menu appears above the Start 

button.  
 
2. Move the mouse pointer up to Programs. A menu opens to the right of 

the word Programs.  
 
3. Move the mouse pointer horizontally until it is over the menu that just 

opened. 
 
4. Move the mouse pointer up to the Accessories menu item. The menu 

item is highlighted in blue.  
 
5. Move the mouse pointer horizontally until it is over the menu that just 

opened. 
 
6. Click to open Paint. 



Introduction To Computers 

Page 5 of 28 

 
7. Click the Close button on the title bar to close Paint.  
 
Review Questions 
You'll find the answers at the end of this workbook. 
 
3. What is the gray bar that runs along the bottom of the screen called? 
             
 
             
 
4. How do you open a program? 
             
 
             
 
5. How would you show someone how to get to the Internet? 
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Working With Windows 
Estimated time: 20 minutes 
 
The “windows” in Microsoft Windows, represents open programs and folders. 
Each window contains different information. For instance, you could have a 
window open that displays a letter you are writing and a window that 
displays a map of the world. When you are working with multiple windows, 
the one you are working in is called the active window. You can tell which 
window is active by its location on top of other windows and also by the color 
of the title bar, which is a brighter color than the others.  
 
Using Common Elements in Windows 
Windows was developed to make it easy for anyone to use a computer. 
Graphical icons are used to represent actions and most of the icons are 
drawn to look like what they represent. For instance, the Save button in 
Microsoft Office programs looks like a floppy disc and the Print button looks 
like a printer. Most programs have at least some things in common, so once 
you learn what to do in one program, you can use that knowledge in another 
program.  
 
Microsoft Office is a set, or suite, of programs designed to work together 
both by sharing a similar look and by sharing information or data between 
programs easily. The Microsoft Office Suite consists of Word, Excel, 
PowerPoint, Access, and Publisher. 
 
Just like there are common elements between different windows, there are 
common elements within suites of programs. A suite of programs is a 
collection of programs that were designed to work together or in a similar 
way. Two common suites of programs are the Microsoft Office suite and the 
Encarta Reference suite. Within each suite is a common set of buttons, 
toolbars, and menus that make it easy for you to learn new programs within 
the suite since you don't need to learn the basic commands for each 
program. For instance, if you know how to make text bold in Microsoft Word, 
you will be able to make text bold in PowerPoint, Publisher, Excel, and Access 
because the steps are the same in each program.   
 
Activity: Locating Common Elements in Windows Programs 
Depending on what type of information a window contains, it will have 
certain elements common to other windows. 
 
1. Double-click the Microsoft Word icon on the desktop. Microsoft Word 

opens.  
 
2. Locate the following items in the Word window: 
 

• Title bar 
• Minimize and Close buttons 
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• Scroll bar 
• Insertion point 
• Menu bar 
• Microsoft Word button on the taskbar 

 
3. Click the Resize button. The window appears smaller and you can see 

part of the desktop. The button between the Minimize and Close buttons 
switches from a Resize button to a Maximize button.  

 
4. Click the Maximize button. The window fills the screen. The button 

between the Minimize and Close buttons switches from a Maximize button 
to a Resize button.  

 
5. Click the Minimize button. The Word window disappears, but there is still 

a button representing it on the taskbar.  
 
6. Double-click the Paint icon. The Paint window opens and a button 

appears on the taskbar.  
 
7. Locate the following items in the Paint window: 
 

• Title bar 
• Minimize and Close buttons 
• Menu bar 

 
Hint: Keep Paint and Word open. 
 
Activity: Switching Between Open Programs 
It can be helpful to have two programs open at the same time. For instance, 
you might be reading a Web page in Internet Explorer and read about a place 
that you want to take a vacation to. You can keep the Web page open and 
use Streets & Trips to find out how long it would take you to drive there.  
 
1. Click the Document1 - Microsoft Word button on the Taskbar. Word 

appears and Paint is hidden behind it.  
 
Hint: If you accidentally closed Word and Paint in the last activity, double-
click the icon on the Desktop to open it again. 
 
2. Click the Paint button on the Taskbar. Paint appears.  
 
3. Click the Resize button on the Paint window. You are able to see both the 

Word and Paint windows.  
 
Hint: Refer to your handout if you forgot what the Resize button looks like. 
 
4. Click the Close button on both open windows. Both windows close and 

there are no longer buttons for them displayed on the Taskbar.  
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The Microsoft Office Menu Bar and Toolbars 
Hint: You located the Menu bar and the toolbars earlier in the section. 
 
All of the Menu bars in Microsoft Office have the File, Edit, View, Insert, 
Tools, Window, and Help menus. Click one of these menus to access a list 
of options. The toolbar contains shortcut buttons to many of the actions you 
can access on the menus from the Menu bar.  
 

• Click the File menu. Become familiar with the New, Save, and Print 
menu items. You can click New to create a new, blank document, click 
Save, to save your current document, and click Print to print your 
current document. Click File again on the File menu to close the 
menu.  

 
• Locate the New, Save, and Print buttons on the toolbar. 

 
• Click the Edit menu. Become familiar with the locations of Cut, Copy, 

Paste, and Undo. Click Edit again to close the menu.  
 

• Locate the Cut, Copy, Paste, and Undo buttons on the toolbar.  
 
Activity: Using Common Office Elements 
Most of the formatting commands are the same in all Office programs. In this 
activity, you will see how easy it is to make text bold in Word and then use 
that knowledge to make text bold in Excel.  
 
1. Double-click the Microsoft Word icon on the desktop. A blank document 

opens in Word.  
 
2. Type hello and press the Enter key on the keyboard.  
 
3. Click the Bold button on the toolbar.  
 
4. Type bye. The text appears darker, or bold.  
 
5. Click the Close button on the title bar. The Office Assistant displays a 

message asking if you want to save the document. Click No. You do not 
need to save changes.  

 
6. Double-click the Microsoft Excel icon on the Desktop. A blank 

spreadsheet opens in Excel.  
 
7. Click the Bold button on the toolbar.   
 
8. Type your name. Bold text appears in the upper-left cell of the 

spreadsheet. 
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9. Click the Close button on the title bar. Click No. You do not need to save 
changes.  

 
Three Helpful Keyboard Shortcuts 
 
1. To quit a program click Alt + F4. 
2. To get help click F1. 
3. To save the active document click Ctrl + S. 
 
Review Questions 
You'll find the answers at the end of the workbook. 
 
6. Where is the title bar located on a window? 
             
 
             
 
7. What does the Minimize button do? 
             
 
             
 
8. If you have two programs open, how do you switch between them? 
             
 
             
 
9. What happens at the insertion point? 
             
 
             
 
10. Does the Bold button look the same in Word, Excel, and Publisher? 
             
 
             
 
11. What does the Cut button look like? 
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Working With Files 
Estimated time: 10 minutes 
 
One of the greatest features of a computer is the ability to save what you are 
working on so you can modify it later without having to recreate it. If you 
type a form letter on a typewriter and you want to customize a sentence for 
each person you are sending the letter to, you will need to type the letter 
multiple times. If you write that same letter in a word processing program on 
a computer, you will only need to retype the sentence you want customized. 
The rest of the letter will adjust to the new text. Once you save the letter, 
you can use it again at a later date. All you will need to do is change the text 
that you want to modify.  
 
Saving Files 
The steps for saving a document are the same in most programs, so once 
you learn to save a document using Microsoft Word, you will have the 
knowledge to save a picture in Paint, or a spreadsheet in Excel.  
 
Activity: Create and Save a Document 
 
1. Insert a floppy disc in the disc drive. 
 
2. Double-click the Word icon on the Desktop. Microsoft Word opens.  
 
3. Type your name. Your name appears at the top of the document. 
 
4. Press the Enter key. The insertion point moves down below your name. 
 
5. Type the city and state you live in. The text appears below your name. 
 
6. Click the Save button. The Save as dialog box opens.  
 
7. Click the downward-pointing arrow next to the Save in box. Select 3½ 

Floppy (A:) from the drop-down list.  
 
8. Double-click inside the File name box. Type me. The text you type will 

replace the text inside the File name box.  
 
9. Click Save. 
 
10. Click the Close button to close Microsoft Word.  
 
Activity: Opening Files 
Once you have saved a document you can open it up again to revise or reuse 
it. 
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1. If necessary, put the floppy disc that contains the file you want to open in 
the floppy drive. 

 
In the Real World: You can follow these steps for a compact disc as well. Just 
select the compact disc instead of the floppy disc when selecting from the 
Look in list. 
 
2. Double-click the Microsoft Word icon on the Desktop.  
 
3. Click the Open button. The button looks like a yellow file folder. The Open 

dialog box opens.  
 
4. Click the downward-pointing arrow next to the Look in box and select 

3½ Floppy (A:). A list of files on the floppy disc appears in the middle of 
the dialog box.  

 
5. Click the file you want to open. 
 
6. Click Open. The file opens in Microsoft Word. 
 
7. Click the Close button to close Microsoft Word.  
 
If You Have Time 
You can also open a file from the 3½ Floppy (A:) icon on the Desktop. 
 
1. Verify the floppy disc is in the floppy disc drive. 
 
2. Double-click the 3½ Floppy (A:) icon on the Desktop. The 3½ Floppy 

(A:) window opens. You should see an icon for the file you just created.  
 
3. Double-click me.doc in the 3½ Floppy (A:) window. Me.doc opens in 

Microsoft Word.  
 
4. You can now revise, print, or save the document with a new name. 
 
5. Click the close button. The Microsoft Word window closes. 
 
If You Have Time: An Introduction to File Management 
Handouts: An Introduction to File Structure 
 
You can create folders on a floppy disc to save and organize your work. As 
you become familiar with the computer, you will be proficient at creating 
folders from the My Computer window as well as when you save a document 
in a Microsoft Office program.  
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Activity: Create a Folder on a Floppy Disc 
 
1. If necessary, put a floppy disc into the disc drive. 
 
2. Double-click the 3½ Floppy (A:) icon on the Desktop. The contents of 

the floppy drive are displayed.  
 
3. Click File > New and select Folder. A folder icon appears in the window 

with the text New Folder highlighted.  
 
4. Type a name for your folder and press the Enter key. 
 
5. You can now drag document icons that are on your floppy disc onto the 

folder icon to move them into it. You can also specify that folder when 
you save a new document.  

 
6. Close the A:\ window.  
 
If You Remember Nothing Else 
You can't harm a computer by experimenting or trying something new, so if 
you think you remember how to do something, try it. The worst that can 
happen is that you learn something new.  
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Section Two:  
Introduction to the Internet 
 
Objectives 
 
• Describe the function and components of the Internet. 
• Use the Internet Explorer browser. 
• Access Web pages 
• Explore features of Internet Explorer using Internet Explorer Help. 
• Print a Web page. 
 
Handouts 
The Internet, True or False 
Harness Email: Email Etiquette 
Internet Explorer Printing 
 
Topic Overview 

Topic Estimated Time 

What is the Internet? 5 

Getting Started with Internet Explorer 10 

Internet Explorer Favorites 15 

Using Internet Explorer Help 5 

Printing from Internet Explorer 15 
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What Is the Internet? 
Estimated time: 5 minutes 
 
The Internet is a worldwide network of computers. Using the Internet, you 
can find information on just about any topic and communicate with people 
throughout in the world.  
 
Activity: The Internet, True or False 
Handout: The Internet, True or False 
 
Complete The Internet, True or False handout as an introductory exercise. 
Answers are provided on the back of the handout. 
 
In the Classroom: Try brainstorming answers as a group. 
 
Instructions: Answer the following questions with true or false. 
Answers are provided on the back. 
 
____ 1.  You have to be “good at computers” to use the Internet. 
 
____ 2.  The World Wide Web and the Internet are different. 
 
____ 3.  The Internet is owned and managed by the U.S. government. 
 
____ 4.  WWW stands for World Wide Wrestling. 
 
____ 5.  You can find anything you need on the Internet. 
 
____ 6.  You need to evaluate information on the Internet for 

accuracy, reliability, and currency. 
 
____ 7.  I am sure there is nothing useful for me on the Web. 
 
Review Questions 
 
1. What is the difference between the Internet and the Web? 
             
 
             
 
2. How do you move from one site to another on the Web? 
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Getting Started with Internet Explorer 
Estimated time: 10 minutes 
 
Internet Explorer is a Web browser that is used to access, view, and navigate 
“pages” on the World Wide Web (the Web). The Web is composed of pages 
with information or graphics. Looking at pages on the World Wide Web is 
commonly called browsing, or surfing. Web pages are accessed by either 
clicking hyperlinks or by typing a Web address in the address bar of the Web 
browser.  
 
A group of pages owned and managed by an individual, company or 
organization is called a “Web site.” Web sites contain a home page, which is 
the first document users see when they enter the site. The site might also 
contain additional documents and files.  
 
Activity: Navigating Internet Explorer 
One of the commonly used Web browsers is Internet Explorer. Open Internet 
Explorer by double clicking the icon on the desktop, or selecting it from the 
Start menu. The first page displayed when Internet Explorer is opened is 
called the home page or the start page.  
 
The Internet Explorer window has six main areas: 
 
• Title bar  
• Menu bar  
• Toolbar  
• Address bar 
• Information area  
• Status bar 
 
The Title bar displays the title of the Web page you are visiting. The Menu 
bar and toolbar provide menus and buttons to navigate the Web or do things 
like print Web pages, change the size of the displayed text, or use Favorites. 
The address bar displays the Web site address of the page you are viewing. 
You can also use the address bar to type in the address of the page you want 
to view. The information area displays the contents of the Web page. The 
Status bar is at the bottom of the window and displays information about the 
page, such as download status and whether the Web site is secure for online 
purchases. Hover the mouse pointer over each button on the toolbar (located 
on the top portion of the screen) and view the tool tip that appears. The 
following table describes buttons available from the Internet Explorer toolbar.  
 

Button Description 
Back Returns to the last Web page viewed. 

Forward Reverses the action of the Back button.  

Home Takes a user to the home page set by the library. 
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Refresh Allows a user to get a fresh copy of the page currently being 
viewed. Good to use for pages that are updated frequently, such as 
weather pages and newspapers.  

Stop Stops a page from loading. 

Search Provides access to a number of search providers. 

Favorites Lists Web Sites in the Favorites Folder. 

 
If You Have Time 
Experiment with the shortcuts on the toolbar, such as copy and paste. 
 
Review Questions 
You'll find the answers at the end of the workbook. 
 
3. What are some reasons why a person would use the Internet instead of 

books in the library? 
             
 
             
 
4. What is the difference between the menu bar and the tool bar?  
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Internet Explorer Favorites 
Estimated time: 15 minutes 
 
Internet Explorer Favorites provide quick access to pre-selected Web sites.  
 
Activity: Exploring the Favorites Folder 
To access the Favorites folder, click the Favorites button on the toolbar. A 
pane will appear on the left listing the Favorites folders and Web sites. To 
open and close a folder, click the folder icon or the text next to the folder. To 
close the Favorites folder, click the close button in the upper right-hand 
corner of the pane. Now, place a Web site in your Favorites folder.  
 
1. In the address bar, type: google.com 
 
2. Select Favorites from the menu bar 
 
3. Move your mouse until it highlights Add to Favorites… 
 
4. Left-click the mouse 
 
5. In the dialogue box that opens, make note of the name of the Web site. 

You can change the name here if you want to.  
 
6. Left-click on the OK button 
 
7. Access the Favorites folder to view the new listing 
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Using Internet Explorer Help 
Estimated time: 5 minutes 
 
Internet Explorer's Help program provides updated information, support, and 
tips for using Internet Explorer. 
 
Activity: Using Internet Explorer Help 
 
To access Help, click Help on the Menu bar and select Contents and Index. 
The Internet Explorer Help dialog box will appear. This dialog box provides 
access to Help Contents and Index. By using the left pane you can browse by 
help topics, search by index entry, or search by topic keyword. The right 
pane displays a specific Help topic. The Help toolbar is located above the two 
panes and allows you to navigate and print Help topics. The print command 
is found in the Options button.  
 
Solve the following scenario using Internet Explorer Help: A co-worker is 
used to the browser Netscape Navigator, and is having difficulty using 
Internet Explorer. You would like to offer them some tips on how the two 
Web browsers are similar and different. What information can you find using 
Internet Explorer Help?  
 
1. Select Help on the Menu bar, and select For Netscape Users. 
 
2. Click Browser Terms in Navigator and Internet Explorer or Internet 

Explorer Keyboard Shortcuts. The Help topic is displayed in the right-
hand pane.  

 
3. Close Help by clicking the Close button in the upper-right corner of the 

Help screen.  
 
Activity: Practice Using The Mouse 
 
Select a site from the options listed (on page 21), and practice 
navigating the Web while you practice using the mouse.  
 
Review Questions 
You'll find the answers at the end of the workbook. 
 
5. How do you access Help in Internet Explorer? 
             
 
             
 
If You Remember Nothing Else  
Internet Explorer is a Web browser that is used to access, view, and navigate 
text and images on the World Wide Web. 
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Mouse Basics 
What is a Mouse?  
A mouse is a pointer tool and an input tool that is attached to your keyboard. 
You can navigate around the computer screen using a mouse.  
 
Holding the Mouse 
Hold the mouse firmly in your right hand. Rest your pointer finger on the left 
mouse button and rest your middle finger on the right mouse button.  
 
Moving the Mouse 
The mouse should be placed on a flat surface, preferably on a mouse pad, 
with the buttons facing up. The mouse pointer moves on the computer 
monitor when the trackball on the underside of the mouse moves. See what 
happens when you pick the mouse up off of the mouse pad and move it to a 
different location. Did the mouse pointer move across the screen? 
 
Click (or Left-click) 
Press the left mouse button once. If you click an icon on the desktop, it will 
become selected. If you click inside a program like Microsoft Word, the 
insertion point moves to that location on the page. 
 
Double-click 
Hold the mouse firmly and quickly click the left mouse button twice. Double-
clicking is used to open a program from an icon on the desktop or to select a 
word in a program. 
 
Click and Drag 
Press the left mouse button down and move the mouse across the mouse 
pad. Release the mouse button. Clicking and dragging is useful to select 
multiple words that are displayed on the computer screen. If you click and 
drag across text inside Internet Explorer, you can then copy and paste it into 
a Microsoft Word document. 
 
Drag and Drop 
Select an object either by clicking or clicking and dragging. Click and drag 
the selected object to another location. This moves the object to a new 
location. Click and drag an icon on the desktop to move the icon to another 
location on the screen. 
 
Right-click 
Press the right mouse button once and a shortcut menu appears that relates 
to where the mouse pointer is pointing. You can use this menu to select 
formatting options for text in Word or to cut and paste text. 
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Practice Using the Mouse 
 
The following websites have some games and other exercises that can help 
you practice using the mouse.  

 
Dot 2 Dot 
http://www.lizardpoint.com/fun/java/dinodots/dino1.html 
 
Make a Match (Memory) 
http://www.lizardpoint.com/fun/java/conc/Memory.html 
 
These two games are Internet versions of the classic games they were 
named for. They will help you with: 
• Pointing (or Mouse-Over)  
• Clicking the Mouse 
 
Pattern Blocks Program 
http://ejad.best.vwh.net/java/patterns/patterns_j.shtml 
 
At this site, you can drag in four different types of shapes of nicely fitting 
sizes into patterns or pictures. Once inside the panel you can rotate them 
and move them. This helps you with: 
• Pointing (or Mouse-Over)  
• Clicking the Mouse 
• Drag and Drop 
 
Mouse Exercises 
http://www.seniornet.org/howto/mouseexercises/mousepractice.html 
 
If you are new to using a mouse, it may take a little practice to get the hang 
of it. Here are some simple exercises to help you get acquainted: 
• Pointing (or Mouse-Over)  
• Clicking the Mouse 
• Drag and Drop 
• Drawing with the Mouse 
 
MouseMASTER 
http://www.clta.on.ca/EAOnline/MouseMaster/index.html 
 
This fun and interactive exercise was developed for computer users at 
beginner level. You will learn to perform various tasks, including: 
• Pointing (or Mouse-Over)  
• Clicking  
• Drag-and-Drop  
• Scrolling  
• Check boxes, radio buttons  
• Menus, lists, text fields  
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An Introduction to File Structure 
Computers use a hierarchical system to organize information. 
To understand how this works, think about the system used 
for organizing files in most offices or at your home. Usually, 
letters and other correspondence are stored in folders in a 
filing cabinet. If there are a lot of items to be filed, the filing 
cabinet will have multiple drawers that files are stored in. 
 
The structure is similar on the computer, except the files are 

stored on discs instead of in cabinets. Most of your files will be stored on the hard 
disc, which is usually called drive C.  
 
If you were storing information regarding the year 2005, you could have a folder 
labeled 2005 and have an additional two folders stored on it, one called Budget, 
for budget information, and the other called Letters & Contracts, for letters and 
contract information. You can have as many files as you want inside a folder, and 
as many folders as you want to help you stay organized.  
 
Creating a Folder on a Floppy Disc 

Once created, you can save new files or move existing files into the folder. 
 

1. Double-click the 3½ Floppy (A:) icon on 
the Desktop. The A:\ window opens. 
 
 
 

2. Click File, select New, and click Folder. A 
folder appears in the window and a box 
surrounds the new folder text.  
 
 

 
3. Type a name for the folder and press the 

ENTER key. The folder is named. 
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Internet Explorer Printing 
 
When using the Internet, people often want to print out the pages they find, or at 
least print selections from those pages. Because many Web sites contain 
information not needed, printing can become a wasteful and time-consuming 
practice. Here are some tips to help you and your organization conserve time 
and resources when printing from the Web using the Internet Explorer browser.  
 
To Print a Single Web Page or Range of Pages  
 
1. Click File on the Menu bar, and select Print Preview. 
2. Click Print. 
3. In the Print dialog box, select Pages from the Print Range options, and enter the 

page numbers you want to print in the text box. 
 
To Print Part of a Web Page in Microsoft Word 
 
1. Select the area of the page you want to print by clicking and dragging to highlight the 

area. 
2. Click Edit on the Menu bar, and select Copy. 
3. Open Microsoft Word from the desktop by double-clicking the icon. 
4. Click Edit on the Menu bar, and select Paste. 
5. Click File on the Menu bar, and select Print. 
 
To Print Part of a Web Page 
 
1. Select the area of the page you want to print by clicking and dragging to highlight the 

area. 
2. Click File on the Menu bar, and select Print Preview. 
3. Click Print. 
4. In the Print dialog box, select Selection from the Print Range options. 
 
To Print an Entire Page from the Web 
 
1. Click File on the Menu bar, and select Print Preview. 
2. Click Print. 
3. 3. In the Print dialog box, select All from the Print Range options.
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Harness E-Mail: E-Mail Etiquette 

When we converse, we expect other people to observe certain rules of behavior. 
The same is true online. Here are a few pointers to help you communicate more 
effectively.  

Clearly summarize the contents of your message in the subject line.  

Properly titled messages help people organize and prioritize their email.  

Avoid using all capital letters.  

USING ALL CAPS MAKES IT LOOK LIKE YOU'RE SHOUTING! IT'S ALSO 
MORE DIFFICULT TO READ.  

Don't use CC (Carbon Copy) to copy your message to everyone.  

This is particularly true at work. These days everyone receives too many e-mails. 
Unnecessary messages are annoying. If only a few people really need to receive 
your message, only direct it to them.  

Similarly, when responding to e-mail, do not respond to all recipients. By 
choosing Reply to All or a similar button when responding to a message, you 
may end up broadcasting your response to your entire company.  

Avoid sending e-mails to large numbers of people unless you have a 
serious reason to do it.  

E-mail broadcast to many recipients may be considered spam. 

Use BCCs (Blind Carbon Copies) when addressing a message that will go 
to a large group of people who don't necessarily know each other.  

Just as it is not polite to give out a person's telephone number without his or her 
knowledge, it is not polite to give out someone's email address. For instance, 
when you send an e-mail message to 30 people and use To or CC to address 
the message, all 30 people see each other's e-mail address. By using BCC, each 
recipient sees only two--theirs and yours.  

Keep your messages short and focused.  

Few people enjoy reading on their computer screens; fewer still on the tiny 
screens in cell phones, pagers and other mobile devices that are becoming 
increasingly popular. Recipients tend to ignore these long messages.  
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Don't write anything you wouldn't say in public.  

Anyone can easily forward your message, even accidentally. This could leave 
you in an embarrassing position if you divulge personal or confidential 
information. If you don't want to potentially share something you write, consider 
using the telephone.  

Nasty e-mails should also be avoided.  

These messages have their own term: flame. Flame e-mail is an insulting 
message designed to cause pain, as when someone "gets burned."  

As a courtesy to your recipient, include your name at the bottom of the 
message.  

The message contains your e-mail address (in the header), but the recipient may 
not know that the return address belongs to you, especially if it is different from 
your real name.  

 

 

 

E-mail etiquette may take time to learn. Don't let your fear 
of making mistakes inhibit you. All Internet users were 
beginners at one time, so most people are quite forgiving. 
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Good Working Positions 
 
To understand the best way to set up a computer 
workstation, it is helpful to understand the concept of 
neutral body positioning. This is a comfortable 
working posture in which your joints are naturally 
aligned. Working with the body in a neutral position 
reduces stress and strain on the muscles, tendons, 
and skeletal system and reduces your risk of 
developing a musculoskeletal disorder (MSD). The 
following are important considerations when 
attempting to maintain neutral body postures while 
working at the computer workstation:  

• Hands, wrists, and forearms are straight, in-line and roughly 
parallel to the floor. 

• Head is level, or bent slightly forward, forward facing, and balanced. 
Generally it is in-line with the torso. 

• Shoulders are relaxed and upper arms hang normally at the side of 
the body. 

• Elbows stay in close to the body and are bent between 90 and 120 
degrees. 

• Feet are fully supported by floor or footrest. 

• Back is fully supported with appropriate lumbar support when sitting 
vertical or leaning back slightly. 

• Thighs and hips are supported by a well-padded seat and generally 
parallel to the floor. 

• Knees are about the same height as the hips with the feet slightly 
forward.  

Regardless of how good your working posture is, working in the same 
posture or sitting still for prolonged periods is not healthy. You should change 
your working position frequently throughout the day in the following ways:  

• Make small adjustments to your chair or backrest. 

• Stretch your fingers, hands, arms, and torso. 

• Stand up and walk around for a few minutes periodically. 
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Review Answers 
 
Section One Answers 
 
1. The floppy disc drive has a smaller hole for the disc. Also the compact disc drive 

says compact on it. 
 
2. A few things the mouse is used for: to open files, move text and pictures, select 

text for formatting, and to select buttons that save files, print documents, and 
number items in a list.  

 
3. Taskbar. 
 
4. Double-click its icon on the desktop. 
 
5. You would show them how to double-click the Internet Explorer icon on the 

desktop. Alternately, you could show them how to click the Internet Explorer icon 
next to the Start button.  

 
6. The top. 
 
7. It hides the window, but keeps the program open. 
 
8. Click the buttons for the programs on the taskbar. 
 
9. Text appears at the insertion point when you type on the keyboard. 
 
10. Yes. 
 
11. Scissors. 
 
Section Two Answers 
 
1. The World Wide Web is one component of the Internet. The Internet is the term 

for a variety of applications, including the Web and e-mail.  
 
2. Clicking hyperlinks or type a Web address in the address bar of the Web browser. 
 
3. While a lot of information is available primarily in books in the library, the 

Internet is the ideal place for information such as: news and up-to-the-minute 
information, government data, specialized knowledge, and newspapers and 
information from other areas of the globe.  

 
4. The Menu bar provides options in text format, and the toolbar provides options 

by buttons. Both allow you to navigate the Web or do things like print Web 
pages, change the size of the displayed text, or use Favorites. 

 
5. Click Help on the menu bar, and choose an option from the drop-down menu. 
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Internet True or False Answers 
 

1. False 
 There are many fabulous directories of high quality Web sites available.  

 
2. True 

The World Wide Web is one part of the Internet, along with e-mail and File 
Transfer Protocol.  

 
3. False 
 The Internet is not owned or managed by any one organization.  

 
4. False 
 WWW stands for World Wide Web.  

 
5. False 

There are many types of information the Internet does not provide access 
to such as full text to many articles and books.  

 
6. True 

Information found on the Internet can be published by virtually anyone. 
Information may be posted on the Internet and consequently not 
maintained or updated.  

 
7. You can find information on everything from genealogy to current statistics 

to basketball and quilting. 
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